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Lesson objectives
 To get an overview of inventory in QuickBooks

 To practice filling out a purchase order for inventory items

 To track the receipt of the inventory items in QuickBooks 

 To adjust inventory manually to enter a stock loss or increase

 To create, build, and edit inventory assemblies (finished goods) (QuickBooks: 
Premier or higher)

 To set up and use units of measure

Supporting materials
 Handout 5: Inventory workflow

 Handout 6: Group vs. inventory assembly items

 PowerPoint file: Lesson 10

 Video tutorial: Inventory Basics: Overview

 Video tutorial: Inventory Basics: Set up 

 Video tutorial: Buying and selling inventory

 Video tutorial: Using reports to manage inventory

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have handouts 5 and 6 ready for distribution.
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To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 In the Restore Backup: Method window, select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Restore Backup: To Location” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field of the Restore To window, type lesson 10 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Turning on the inventory feature

The QuickBooks inventory feature is turned on in your exercise file, but you’ll review 
how to turn on this feature so you become familiar with QuickBooks preferences. If you 
need to track inventory for your company, you can turn the feature on while completing 
the EasyStep Interview. If you want to turn on the inventory feature after you’ve 
completed the EasyStep Interview, follow this procedure.

To turn on the inventory feature:
1 From the Edit menu, choose Preferences.

2 Select Items & Inventory from the left panel.

3 Click the Company Preferences tab.

Note: Only the QuickBooks Administrator can change company preferences.

4 Click the “Inventory and purchase orders are active” checkbox to select it.

A checkmark shows that the inventory feature is turned on.

5 Click OK.
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Entering products into inventory

QuickBooks uses the average cost method to determine the value of inventory (rather 
than another method such as FIFO or LIFO). The average cost of an inventory item 
equals the total cost of the items currently in stock, divided by the number in stock.

Many small businesses that stock inventory don’t know the number of units they have 
on hand or on order at any given time, and have no way of getting that information 
quickly. Using QuickBooks to manage your inventory, you’ll be able to track the number 
of items in stock and the value of your inventory after every purchase and sale. As you 
order inventory items, receive the items, and later sell the items from inventory, 
QuickBooks tracks each inventory-related transaction. You will know the status of your 
inventory and will have a more accurate picture of your business’s assets.

Refer to the diagram on Handout 5, “Inventory workflow” for the following discussion.

To track inventory, you must enter each product into the Item list as an inventory part. 
Once you enter a product, QuickBooks tracks it as you sell or reorder the product.

To enter a product into inventory:
1 From the Vendors menu, choose Item List.

QuickBooks displays the Item list.

2 Click the Item menu button, and then choose New.

QuickBooks displays the New Item window.

You’ll enter one new item into your inventory.
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3 In the Type field, choose Inventory Part from the drop-down list.

QuickBooks changes the New Item window to accept information for an inventory 
part.

4 In the Item Name/Number field, type Cab 2015 (2015 is the style number).

5 Select the “Subitem of” checkbox, and then choose Cabinets from the drop-down 
list.

Note: You can use the Manufacturer’s Part Number field to specify the part number 
the manufacturer uses. This can simplify reordering.

6 In the “Description on Purchase Transactions” field, type Kitchen Cabinet #2015, and 
then press Tab to move to the Cost field.

Notice that QuickBooks fills in the Description on Sales Transactions field with the 
same description you entered for the purchase side. You can leave the sales 
description the same or change it later.

7 In the Cost field, type 169.

8 In the Preferred Vendor field, choose Thomas Kitchen and Bath from the 
drop-down list.

Or, type the first few letters of your selection and QuickBooks fills in the rest.

9 In the Sales Price field, type 225.

10 Leave the Tax Code setting as is.

If you wanted to assign a different tax code, you could select a different code from 
the drop-down list when setting up the item.
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11 In the Income Account field, choose Construction:Materials.

12 Press Tab to move to the Asset Account field.

Inventory Asset was filled in when you selected Inventory Part as the type of item. 
Leave this default setting.

13 In the Reorder Point field, type 15.

The Reorder Point is the minimum quantity of a particular inventory item that you 
want to have in stock at any given time. When the quantity reaches the reorder 
point, it's time to order more of the item. By using your Reminders list, you can have 
QuickBooks remind you when it's time to reorder a particular item.

14 In the On Hand field, type 20, and then press Tab to move to the Total Value field.

Notice that QuickBooks has calculated the value of your item by multiplying the 
number in the On Hand field by the number in the Cost field.

Your New Item window should resemble the following figure.

15 Click OK to close the New Item window.

QuickBooks adds the new item to the Item list.

16 Close the Item list.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the inventory item. 
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Ordering products

Once you enter your current products and vendors into the Item and Vendor lists, you’ll 
need to order products to keep your inventory stocked.

QuickBooks doesn’t require you to use purchase orders, but you may want to recommend 
their use for students who track inventory. Using purchase orders lets you see items you 
have on order and when they’re due to be received. You can also check items you receive 
against the PO.

If students don’t order items in advance or don’t want to use purchase orders, they can 
buy inventory directly by writing a check or entering a credit card transaction.

Creating purchase orders

When you order items from a vendor, you create a purchase order.

Account Title Debit Credit

Opening Bal Equity $3,380.00

Inventory Asset $3,380.00

QuickStart Tip
When you want to check on the status of your inventory stock, you can create a stock 
status by item report. For every item in your inventory stock, the report gives you the reor-
der point, the current quantity on hand, the average cost to date, the quantity on order 
(and expected date of receipt), and the average sales per week.
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To order a product using a purchase order:
1 From the Vendors menu, choose Create Purchase Orders.

QuickBooks displays the Create Purchase Orders window.

You use the Create Purchase Orders window to enter the products you wish to order, 
the quantities, and the vendor. As you fill in this information, QuickBooks 
automatically calculates purchase order number, item cost, and total cost.

Notice that QuickBooks has already entered today’s date and a sequential purchase 
order number.

2 In the Vendor field, choose Perry Windows & Doors from the drop-down list.

Notice that QuickBooks displays all of the information about 
Perry Windows & Doors in the appropriate places on the purchase order form.

3 In the Item column, select Frames:Exterior Frame from the drop-down list.

4 In the QTY field, type 10.
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5 In the Vendor Message field of the purchase order, type Please rush ship this order.

Your Purchase Order should resemble the following figure.

6 Click Save & Close to record the purchase order.

After you have created a purchase order, QuickBooks adds an account to the chart of 
accounts called Purchase Orders. This is a non-posting account and does not affect your 
balance sheet or income statement. The Purchase Orders account is used to produce a 
QuickReport showing current purchase orders so you always know what is on order.
285



S e t t i n g  u p  i n v e n t o r y
Getting a report of purchase orders

To get a chronologically ordered report of all the purchase orders 
you have written:
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, click Purchase Orders once to select it.

By default, QuickBooks lists non-posting accounts at the bottom of the list.

3 Click the Reports menu button and choose QuickReport: Purchase Orders.

QuickBooks displays a report of all purchase orders.

Notice the purchase order you have just created is at the bottom of the report.

4 Close the QuickReport.

5 Close the chart of accounts.
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Receiving inventory

When you receive the items you have ordered with your purchase order, you have to 
enter the items into inventory. You can receive items with a bill or without a bill.

This exercise shows you how to enter into QuickBooks inventory items you’ve received 
when the bill for those items will follow later.

To receive inventory without a bill attached:
1 From the Vendors menu, choose Receive Items.

QuickBooks displays the Create Item Receipts window.

The Create Item Receipts window lets you enter information for inventory parts 
you’ve received.

2 In the Vendor field, choose Perry Windows & Doors from the drop-down list and 
press Tab.

QuickBooks tells you that there are open purchase orders for this vendor and asks if 
you wish to receive against one of these orders.
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3 Click Yes.

QuickBooks displays the Open Purchase Orders for Perry Windows & Doors.

4 Click the third purchase order (#40, dated 12/15/2015) to select it.

QuickBooks places a checkmark in the left-most column for the item selected.

5 Click OK to move the information to the item receipt.

The Create Item Receipts window should resemble the following figure.

6 Click Save & Close to process the receipt.

QuickBooks processes the items and adds them to your inventory. If you display the 
Item list, you’ll see that you now have 10 additional door frames on hand.
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Entering a bill for inventory

If you've entered an item receipt for inventory, but the bill hasn't arrived yet, you can 
still record the bill amount in QuickBooks. Entering the bill as shown in this exercise 
records the amount in your accounts payable account so you can track how much you 
owe.

When the bill comes, you pay the bill just like you would pay any other bill in 
QuickBooks (from the Pay Bills window).

To enter the bill:
1 From the Vendors menu, choose Enter Bill for Received Items.

QuickBooks displays the Select Item Receipt window, where you can select the 
vendor and the item for which you have a bill.

2 In the Vendor field, select Perry Windows & Doors in the drop-down list 
and press Tab.

QuickBooks fills in the Date and Memo fields with information that corresponds to 
your bill.

3 Select “Received items (bill to follow),” dated 12/15/2015. 
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4 Click OK.

QuickBooks displays the Enter Bills window.

5 Click Save & Close.

6 Click Yes if another dialog box appears.

QuickBooks changes the item receipt to a bill in the Accounts Payable account and 
lists the bill in the Pay Bills window. If you look at the Accounts Payable, you’ll see 
that the balance increased by $200.00, based on the bill entered for 
Perry Windows & Doors.

Because you must have inventory on hand before you can enter a sale for inventory 
parts, we recommend that you enter your item receipts before entering sales.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the bill payment. 

Account Title Debit Credit

Accounts Payable $200.00

Inventory Asset $200.00
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Manually adjusting inventory

When you have spoilage or send out samples of your products, you can adjust your 
inventory manually.

To adjust the inventory manually:
1 On the Home page, click Adjust Quantity on Hand.

QuickBooks displays the Adjust Quantity/Value on Hand window.

The Adjust Quantity/Value on Hand window lets you enter the adjustment account, 
and either the New Qty or the Qty Difference.

Since two wood interior doors were damaged, you’ll adjust the inventory account to 
remove two doors.

You may want to point out to students that they can also adjust inventory value 
without affecting quantities by selecting the Value Adjustment checkbox.

2 In the Adjustment Account field, type Inventory Adjustment and press Tab.

3 Click Set Up in the window telling you that Inventory Adjustment is not in the 
account list.

QuickBooks opens the Add New Account window.
291



S e t t i n g  u p  i n v e n t o r y
4 In the Account Type field, choose Expense from the drop-down list, if it is not 
selected already.

5 Click Save & Close to close the Add New Account window.
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6 In the Qty Difference column for Wood Door:Interior wood door, type –2 (the 
number of damaged doors), and then press Tab.

QuickBooks calculates the value adjustment and decreases the inventory by two 
items.

7 Click Save & Close.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the inventory adjustment.

Account Title Debit Credit

Inventory Asset $137.00

Inventory Adjustment $137.00

QuickStart Tip
The inventory valuation reports in QuickBooks break down the value of your inventory 
and give you several statistical measures of its value. The valuation summary report shows 
the quantity on hand, average cost, asset value, % of total asset value, retail value, and % of 
total retail value for each of your inventory items. The valuation detail report lists the 
opening balance, ending balance, and every transaction (purchase or sale) that has 
affected the inventory value of each inventory item during the period of time 
covered by the report.
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Tracking finished goods

QuickBooks Premier products let you track the building and sale of finished goods using 
assembly items. When you define assembly items, you tell QuickBooks how many of 
each inventory item is needed to create the finished product.

Inventory assembly items allow you to create an item that contains assembled material 
units (finished goods) you buy or produce, track as inventory, and resell. You can keep 
track of how many items remain in stock after a sale, how many items you have on order, 
your cost of goods sold, and the value of your inventory. Note that inventory assembly 
items in QuickBooks are appropriate for indicating “light” assembled items on sales 
forms and in reports. QuickBooks does not track inventory throughout a 
manufacturing process.

You must have a QuickBooks Premier product to create and build inventory assembly 
items. Afterwards, you can use any desktop for Windows edition of QuickBooks to view, 
sell, and report on existing assembly items.

Deciding whether to use group items or create inventory 
assemblies

Both group items and inventory assembly items record a group of items as a single entry 
on purchase or sales forms in QuickBooks. (Group items are available in 
QuickBooks Pro and higher editions.)

Refer to Handout 6, “Group vs. inventory assembly items” for more information about 
choosing between group and inventory assembly items.

Using group items

Group items are useful for quickly entering a group of individual items that you've 
already set up as single items on your list and often sell together.

Group items let you track the items you sell in greater detail. For example, a 
construction firm that remodels houses could set up a group item that lists the 
significant components of a remodeling job: lumber, carpentry hours, markup, etc. 
Sales reports for the company would then show income broken down by each 
component instead of a single lump sum for all remodeling jobs.

If you need to track a lot of detail about your items but you also want to give your 
customers simple, uncluttered invoices, you can use group items to do both. You can set 
up a group item so that the printed version of an invoice reduces a group item to a single 
line item and one amount. Yet when you view the invoice on your screen, you see a 
separate line entry and amount for each item in the group.
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Group items also give you a way to enter a great amount of line item detail quickly. On 
a sales or purchase form, all you have to do is enter the name of the group item—
QuickBooks fills in all the details about the items in the group for you.

Using inventory assemblies

When you build an assembly, an assembled unit is automatically added to quantity on 
hand and its component parts (inventory items or other assembly items) are 
automatically deducted from quantity on hand. By using assembly items, you always 
know how many assembled and component items you actually have in stock.

You can specify a price for an assembly that's different than the sum of component 
items.

You can easily access the date items were assembled, quantity and cost of assembled 
items, and a detailed bill of materials.

You can set a build point and QuickBooks will automatically remind you to build 
finished goods when stock is running low. At build time, QuickBooks will notify you if 
you don't have enough component items in stock to build the specified number of 
assembly items.

Note: The ability to create inventory assemblies is available only in QuickBooks 
Premier and higher. To proceed through this exercise, you must be using a 
QuickBooks Premier or higher edition.

Setting a default markup

With QuickBooks, you can add a markup to your basic costs by entering a default 
markup percentage. QuickBooks uses this percentage to calculate the sales price of 
items that have both a cost and a sales price.

You'll see the effect of the default markup percentage when you create inventory part, 
non-inventory part, service, and other charge items. When you enter the item's cost, 
QuickBooks calculates the sales price and enters it in the Sales Price field. For example, 
entering a cost of $10.00 when the markup is 25% causes QuickBooks to fill in the sales 
price as $12.50. If you don't want to use the default markup for an item, you can change 
the sales price that QuickBooks fills in.

To set the default markup percentage:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the left panel.

3 Click the Company Preferences tab.

4 In the Default Markup Percentage field, type 20 and press Tab.
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5 In the Default Markup Account field, choose Construction.

Your screen should look like this:

6 Click OK.

You’ll see the affects of this markup percentage in the next exercise.
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Adding a labor item to use in assemblies

Suppose you have plans to sell all the items needed for installing a door as a kit. You’ll 
also need to account for the labor needed to assemble the kit. To do this, you’ll create an 
“Assembly Labor” item.

To create a labor item to use in assemblies:
1 From the Lists menu, choose Item List.

2 Click the Item menu button and select New.

QuickBooks displays the New Item window.

3 In the Type field, select Service.

4 In the Item Name/Number field, type Assembly Labor.

5 Click the checkbox for “This service is used in assemblies or is performed by a 
subcontractor or partner.”

The New Item window expands so you can enter details that will be used for this 
item in both sales and purchase transactions.

6 In the Description on Purchase Transactions field, type Direct Labor, and then press 
Tab.

7 In the Cost field, type 20, and then press Tab.

QuickBooks automatically enters the Sales Price based on the 20% markup you set 
in the Company preferences.

8 From the Expense Account drop-down list, choose Payroll Expenses.

9 From the Tax Code drop-down list, choose Non-taxable Labor.
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10 From the Income Account drop-down list, choose Construction:Labor.

Your screen should look like this:

11 Click OK.

Creating inventory assembly items

Creating assembly items in QuickBooks is a two-part process: first you define an 
assembly item, and then you build the assembly. Assembly item units are not added to 
inventory and assembly components (inventory parts or other assemblies) are not 
deducted from inventory until you build the assembly.

Inventory assembly items can include inventory part and other assembly items. You can 
also include the costs associated with building the assembly item by adding 
non-inventory part items, service items, and other charge items to the Bill of Materials.

All items included in an inventory assembly item must be defined in the Item list. You 
can define them before you create the inventory assembly item, or as you create the 
assembly item. 

In addition to selling individual items, Rock Castle sells pre-assembled exterior door 
kits. In this exercise, you define the assembly item for the exterior door kits. All of the 
component items are already defined in the Item list.
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To create an inventory assembly item:
1 In the Item List, click the Item menu button and select New.

QuickBooks displays the New Item window.

2 In the Type field, select Inventory Assembly.

3 In the Item Name/Number field, type Exterior Door Kit.

4 Type 199 in the Cost field, and then press Tab twice.

QuickBooks calculates the Sales price based on the cost you enter in this field and 
the default markup percentage as set in the company preferences. Leave the COGS 
Account as is.

5 In the Description field, type Complete exterior door kit, and press Tab.

The New Item window should resemble the following graphic.

QuickBooks allows you to set any price for assembled items; the price is 
independent of the sales price of the component items. You could change this 
amount if you wanted.

The Sales Price reflects the cost plus the 20% markup you entered in preferences, so 
leave it as is.

In addition, the tax code for the assembled item and the component parts can be 
different. 
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6 In the Income Account field, select Construction:Materials from the drop-down 
list.

7 In the Bill of Materials section, click in the Item column.

8 In the Item drop-down list, select Frames:Exterior Frame, and then press Tab.

9 In the Qty field, type 1, and then press Tab.

10 In the Item drop-down list, select Hardware:Doorknobs Locking Exterior, and then 
press Tab.

11 In the Qty field, type 1, and then press Tab.

12 In the Item drop-down list, select Hardware:Brass Hinges, and then press Tab.

13 In the Qty field, type 3, and then press Tab.

14 In the Item drop-down list, select Wood Door:Exterior, and then press Tab.

15 In the Qty field, type 1, and then press Tab.

16 In the Item drop-down list, select Assembly Labor, and then press Tab.

17 In the Qty field, type 1, and then press Tab.

The New Item window should resemble the following graphic.

You can edit the Bill of Materials for an assembly item at any time. However, 
assembly revision history is not tracked; if you need to build a previous version of an 
assembly, you need to edit the assembly and reenter the original bill of materials.
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Entering the build point

You can have QuickBooks remind you to build this assembly when your inventory 
quantity reaches a certain level. (Assembly Items to Build must be turned on in the 
Company Preferences for Reminders.) QuickBooks will remind you to build when the 
combined value of the quantity on hand and the quantity on order (from a purchase 
order) falls below the value displayed in the Build Point field. Reminders appear in the 
Reminders window. In QuickBooks Premier or Enterprise Solutions editions, you can 
rebuild directly from the Reminders list in any of these windows.

To enter the build point:
1 In the Build Point field, type 5.

2 Leave the On Hand and Total Value fields as they are.

The New Item window should now resemble the following graphic.

3 Click OK.

4 Close the Item list.
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Building finished goods

Once you’ve created assembly items that define the pieces you build, you are ready to 
enter the builds into QuickBooks. In this exercise, you build two exterior door kits for 
Rock Castle.

To build an inventory assembly:
1 From the Vendors menu, choose Inventory Activities, and then choose Build 

Assemblies from the submenu.

QuickBooks displays the Build Assemblies window.

2 In the Assembly Item field, select Exterior Door Kit from the drop-down list.

3 In the Quantity to Build field, type 2.

The Build Assemblies window should resemble the following graphic.

QuickBooks warns you when you do not have sufficient inventory items on hand to 
complete a build.

If you choose to build an assembly and do not have enough components in 
inventory to build the number of assemblies you have specified, you can postpone 
the build by marking it pending. If you don’t mark the build as pending, you have 
to reduce the number of assemblies or you won’t be able to save the build.

You have enough inventory to build two assemblies, so you can proceed with the 
build.

4 Click Build & Close.
302



                                                                                                
L E S S O N  1 0
Understanding the effect of builds on inventory

When you build an assembly item, QuickBooks decrements the appropriate number of 
individual inventory items from inventory and increments the number of inventory 
assembly items. It takes the inventory asset value of the component items and transfers 
the value to the assembly item. The parts and the values are combined into the quantity 
and value of the assembly item.

To generate an item list, go to the Reports menu, choose List, and choose Item Listing 
from the sub-menu.

The following graphic shows the number of component and built items before the 
build. (Note that these graphics show reports that have been modified to show only the 
information relevant to the inventory assembly item you created.)

The following graphic shows the number of component and built items after the build.
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Managing pending builds

A pending build is an inventory assembly build transaction that could not be finalized 
because there were not enough component parts in inventory to build the specified 
number of assemblies at build time. When a build is pending, “Pending” appears in the 
Build Assemblies window to remind you that these assemblies haven't been built.

If you modify or delete a previous build transaction, or change inventory quantities or 
the dates of purchase orders, invoices, or sales receipts, assembly builds that were 
finalized could change to pending. Finalized builds change to pending when the 
quantity of at least one component drops below the quantity needed to build the 
specified number of assemblies on the build transaction date. You can use the pending 
builds report to see a list of all builds that are currently pending.

In addition, you can choose to manually mark a build as pending even if you currently 
have enough components in stock to build the specified quantity. This allows you to set 
up build information but postpone building the assembly until later. 

Disassembling inventory assemblies

There are several ways to disassemble inventory assemblies and return component 
items to inventory. You can do any of the following:

 Use the Adjust Quantity/Value on Hand window to adjust the quantity on hand for 
each assembly component and the assembly item.

 Reduce quantity to build in the Build Assemblies window and then click Build & 
Close. The quantity of assembly units in inventory are decreased and the quantity 
of component inventory parts are increased accordingly.

 Delete a build transaction completely. The quantity of assembly units in inventory 
is decreased and the quantity of component inventory parts is increased 
accordingly, but this method completely removes the build transaction from 
QuickBooks and should not be used if you want to maintain a record of the 
transaction.

Selling finished goods

When assembly items appear on any form (for example a sales receipt or in a report), 
their component items are hidden. Only the assembly name, description, and price 
appear.

If you attempt to sell more assembly units than you have available in inventory, 
QuickBooks warns you that quantities are insufficient to fulfill the order. If you decide 
to go ahead with this transaction, the quantity on hand for the specified assembly 
changes to a negative value. You can set a build point in the Build Assemblies window 
to remind you when assembly stock is getting low and you need to build more units. If 
you turn on reminders, a list of assemblies that need to be built appear in the Reminders 
window.
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Using units of measure

Note: You must be using certain editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions to follow the exercises in this section. The exercises in the 
remainder of this lesson require the use of editions of QuickBooks that support 
units of measure functionality. Some of the exercises require the use of an 
edition that supports single units of measure; others require the use of an 
edition that supports multiple units of measure. You’ll find a list of the editions 
that support single and/or multiple units of measure below.

Using units of measure can show what quantities, prices, rates, and costs are based on. 
You set up the units of measure and assign them to Service, Inventory Part, 
Non-inventory Part, Inventory Assembly, and Group items. Some businesses need to 
track transactions using only a single unit of measure, for example, a business buys 
inventory by the gallon and sells by the gallon. Service businesses also may track by only 
one unit of measure, such as by the hour. Other product-based businesses buy, sell, and 
stock inventory items in multiple units of measure. A business may receive inventory in 
one unit, store it in another, and sell and ship the items in a third unit of measure. 
Service businesses might also use multiple units of measure, for example if they bill by 
the hour and by the day.

QuickBooks provides two different ways or modes for assigning units of measure to 
items: single unit of measure per item and multiple unit of measure per item. The 
following editions of QuickBooks support only the Single U/M Per Item mode:

 QuickBooks Premier

 QuickBooks Premier Non-Profit

 QuickBooks Premier Professional Services

The following editions of QuickBooks support both the Single U/M Per Item and 
Multiple U/M Per Item modes:

 QuickBooks Premier Accountant

 QuickBooks Premier Contractor

 QuickBooks Premier Manufacturing & Wholesale

 QuickBooks Enterprise Solutions (all editions except Retail)

QuickBooks provides two ways to set up the unit of measure modes. You can turn on the 
mode in Preferences, or you can turn it on through the Item list.
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Setting up single unit of measure mode

Note: You must be using one of the editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions that supports single units of measure to follow the 
exercises in this section.

In Single mode you can assign different units of measure to different items, but each 
item can have only one unit of measure assigned to it. If you buy, stock, and sell each 
item by the same unit of measure, set up single unit of measure mode. For example, 
choose this mode if you buy an item by the foot, keep track of it in inventory by the foot, 
and sell it by the foot.

To set up single units of measure:
1 On the Home page, click Items & Services to open the Item List.

2 Select the non-inventory part item called Lumber: Decking.

3 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Decking.
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4 To turn on the unit of measure mode, click Enable.

This starts the unit of measure wizard where you set up the base unit.

Choosing single units of measure lets you define a base unit. Rock Castle buys and 
sells the decking lumber by the foot.

5 Select Single U/M Per Item.

6 Make sure “Begin defining units of measure” is selected and click Next.

You’ll next select the type or category of measure units.

7 Since Rock Castle will buy and sell by the foot, select Length as the unit of measure 
type. 

8 Click Next.

Now, you select the base unit. 
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9 Select Foot as the base unit.

The base unit should be the smallest unit of measure used for an item when 
purchasing it, tracking it in inventory, and selling it. In QuickBooks, the base units 
of items are used to count inventory, generate most inventory reports, and perform 
quantity-related calculations.

10 Click Finish.

11 Click OK in the Edit Item window and close the Item List.

Setting up multiple units of measure

Note: You must be using one of the editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions that supports multiple units of measure to follow the 
exercises in this section.

If you buy, stock, or sell items in different units, set up multiple units of measure. For 
example, choose this mode if you buy an inventory item by the gallon and sell it by the 
ounce, or if you sell consulting services by both the hour and the day.

If you choose Multiple mode, you define unit of measure sets that you can assign to 
items. A unit of measure set consists of a base unit (usually the smallest unit used to track 
a certain type of item) and any number of related units (defined as containing a certain 
number of base units). For example, you could create a unit of measure set called 
“Length by the inch” with a base unit of inch and related units of foot (containing 12 
inches) and yard (containing 36 inches).
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With Multiple mode, you can change or convert the unit of measure when you enter an 
item on a transaction form, such as an invoice or purchase order. For example, suppose 
you have an item called Cable that you've assigned a unit of measure set that contains 
the inch, foot, and yard units of measure. If you enter Cable on an invoice with a 
quantity of 30 feet, you could then change the unit of measure to yards (causing 30 feet 
to become 30 yards) or convert the unit of measure to yards (causing 30 feet to become 
10 yards).

Rock Castle purchases and sells inventory items in different units of measure. To track 
the different units of measure, you need to turn on multiple units of measure.

Turning on multiple units of measure mode

Depending on how your company file has been set up, you turn on the multiple units 
of measure mode in one of two ways. If your file has not yet been set up with units of 
measure, skip ahead to the procedure on page 310.

If your file has already been set up with single units of measure (as with the qblesson 
company file, you’ll need to switch from single to multiple mode. Follow the next 
procedure.

To switch from single to multiple units of measure:
1 From the Edit menu, choose Preferences.

2 Click Items & Inventory, and then click the Company Preferences tab.

3 From the U/M drop-down menu, choose Multiple U/M Per Item.

4 Click OK.
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5 Click OK at the message that appears to notify you that QuickBooks must close all 
open windows to switch to multiple units of measure.

6 Continue with the procedure in “Assigning units of measure to items” on page 311.

To turn on multiple units of measure in a company file the first time:
1 From the Edit menu, choose Preferences.

2 Click Items & Inventory, and then click the Company Preferences tab.
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3 In the U/M section, click Enable.

4 Select Multiple U/M Per Item.

5 Click Finish.

QuickBooks returns to Preferences.

6 In the Preferences window, click OK.

7 Click OK if a message appears to notify you that QuickBooks must close all open 
windows to switch to multiple units of measure.

8 Continue with the procedure in the next section.

Assigning units of measure to items

Rock Castle sells countertops that can be customized according to a customer’s wishes. 
One customer who is remodeling a kitchen wants Italian marble for the countertop. 
Rock Castle has a non-inventory part item called Counter for materials they purchase 
on behalf of a customer but that they don’t normally carry in stock. Rock Castle 
purchases the marble in square meters, but charges the customer by the square foot. To 
track the different units of measure, you’ll assign units of measure to items.

To assign multiple units of measure:
1 Click Home on the icon bar to open the Home page.

2 On the Home page, click Items & Services to open the Item List.

3 Select the non-inventory part item called Counter.
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4 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Counter.

5 In the Unit of Measure section, click Enable.

6 Make sure “Begin defining units of measure” is selected and click Next.

You’ll next select the type or category of measure units.

This starts the unit of measure wizard where you set up the base unit and any related 
units.

Choosing multiple units of measure lets you define a base unit and multiples of that 
base unit. Since Rock Castle buys the marble countertop in square meters and sells 
the countertop in square feet, you define a measure set for area.
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7 Select Area as the unit of measure type. 

You’ll be defining a measurement set called Area that consists of a base unit and 
related units.

8 Click Next.

9 Select Square foot (sqft) as the base unit.

The base unit should be the smallest unit of measure used for an item when 
purchasing it, tracking it in inventory, and selling it. In QuickBooks, the base units 
of items are used to count inventory, generate most inventory reports, and perform 
quantity-related calculations. 
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10 Click Next.

QuickBooks displays the window where you define the units related to the base 
unit. Related units make it possible to show quantities of the same item in different 
measurements in different places in QuickBooks. Rock Castle purchases the marble 
by square meter, counts that item in inventory by the square yard, and sells it by the 
square foot. By creating a unit of measure set with a base unit of square foot and 
related units of square meter and square yard, you can enter a quantity of square 
meters on a purchase order, show the item in square yards on inventory reports, and 
enter a quantity of square foot on an invoice.

11 Click in the Add column for Square Yard and Square Meter.

Notice that QuickBooks has already calculated the number of base units the related 
unit contains in the # of sqft column.

12 Click Next.

Next, you’ll select the default unit of measure to use when buying this item and 
when selling and shipping this item.
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13 From the Purchase drop-down menu, select square meter.

Since Rock Castle buys by the square meter, that’s what you want to appear by 
default on purchase orders for this item.

14 Leave the Sales default as square foot and leave the Shipping default blank.

15 Click Next.

You need to give this measure set a name.

16 Click Finish to accept the suggested name of this unit of measure set.

QuickBooks returns you to the Edit Item window. Notice that the Counter item has 
been assigned the Area by the square foot measurement set.

17 Click OK in the Edit Item window.
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Assigning measure sets

You can create several measure sets for your company that you can assign to items. You 
just created a measure set for area for Rock Castle. Since Rock Castle buys and sells other 
items using different measurements, you could create a measure set for count (each, 
pair, dozen, and so on) and another one for length (inch, foot, yard, and so on). The 
number of measure sets you create will depend on your business needs.

After creating the measure sets, you’ll need to go through the items in your Item List and 
assign the unit of measure set to use for each item.

To assign a unit of measure set to an item:
1 In the Item List, select the non-inventory part item called Flooring.

Rock Castle also buys and sells flooring by area, so you can assign the Area measure 
set to this item.

2 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Flooring.

3 Select Area by the square foot from the U/M Set drop-down menu.

4 Click OK in the Edit Item window.

5 Close the Item List.
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Using units of measure on sales forms

Rock Castle needs to order the marble for the kitchen remodel. In this exercise, you 
order the marble using a purchase order, and see how you could easily convert from one 
unit of measure to another unit within the same measure set.

To convert units of measure on sales forms:
1 In the Vendors area of the Home page, click Purchase Orders.

2 On the purchase order, select Custom Kitchens of Bayshore.

Rock Castle orders the marble from this vendor.

3 Click in the Item column and select Counter.

4 In the Quantity column, type 10.

Your screen should resemble the following graphic.

Notice that QuickBooks displays a menu you can use to specify the unit of measure 
if you want to change it. For this exercise, leave the measurement as 10 sqm.
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5 Click the down arrow in the U/M column to open the conversion menu. 

Notice that QuickBooks uses the default unit you selected for purchasing this item. 
You can use the menu to convert to other units of measure within the Area measure 
set you created. For this exercise, leave the unit of measure as sqm.

6 Click Save & Close.

Once you've created a unit of measure set and assigned it to an item, you can easily 
convert to other units of measure within the set when you add the item to a transaction. 
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